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Introduction

 

Mac OS 8 is the most significant update to the Macintosh 
operating system since 1984.  The updated system gives 
users PowerPC-native multitasking, an efficient desktop 
with new pop-up windows and spring-loaded folders, and a 
fully integrated suite of Internet services. 

This document provides information about Mac OS 8 that 
supplements the information in the Mac OS installation 
manual. For a detailed description of Mac OS 8, useful tips 
for using the system, troubleshooting, late-breaking news, 
and links for online technical support, visit the Mac OS Info 
Center at http://ip.apple.com/infocenter.  Or browse the 
Mac OS 8 topic in the Apple Technical Library at http://
tilsp1.info.apple.com.
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About Mac OS 8

 

Read this section for information about known problems 
with the Mac OS 8 update and possible solutions. 

 

Known Problems and Compatibility Issues

 

Apple Language Kits and Mac OS 8

 

Apple's Language Kits require an updater for full 
functionality with this version of the Mac OS.  The Language 
Kit Updater for Mac OS 8 can be downloaded from the 
software updates area of Apple's Web site, America Online, 
and other sites where Apple updates are available.

If you cannot obtain the Language Kit Updater right away, do 
the following as an interim method of improving 
compatibility: After installing Mac OS 8, open the Installer 
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again and add the International components of the basic 
system software. (See “Adding and Removing Software” in 
Chapter 3 of the installation manual.) Then reinstall your 
Apple Language Kit software. If the Language Kit installer 
asks about older files, always choose Newer.

 

At Ease and Mac OS 8 

 

Some of the Mac OS 8 control panels can't be enabled for At 
Ease users and won't appear in At Ease Setup. You should use 
these control panels in the Finder before running At Ease. 
Also, note that At Ease does not support file sharing. Do not 
turn on file sharing when using At Ease or your computer 
may freeze.
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Apple Location Manager and Mac OS 8

 

To use the Apple Location Manager with your PowerBook 
computer, you must install Apple Location Manager 1.0.1, 
which is included with Mac OS 8. Due to changes in Mac OS 8, 
previous versions of Apple Location Manager will not 
function correctly and should not be used.

 

Programs Refuse to Open

 

Some programs refuse to run if the system font is set to 
anything but Chicago. To change the system font, use the 
Appearance control panel and change the font from Charcoal 
(the default) to Chicago then restart your computer and try 
to open the program again. Contact the manufacturer of the 
program to see if an updated version is available.

Additionally, some programs might require a small amount 
of additional memory when used with Mac OS 8. If a program 
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refuses to open, increase its minimum memory allocation by 
200K or 300K. To do this, select the program's icon, then 
open the File menu and choose Get Info. See the Memory topic 
in Mac OS Help for more information.

 

Printing with a LaserWriter Select 300 or 360 printer

 

If you experience system freezes or other problems when 
printing on a LaserWriter Select 300 or 360 printer, make 
sure the printer is connected to the computer. Trying to 
cancel printing does not solve the problem and may cause a 
flashing error message or cause your computer's 
performance to slow down.

 

Using Mac OS 8 with HP Printers

 

If your computer freezes or crashes when you use the Page 
Setup dialog box, contact Hewlett-Packard to obtain updated 
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drivers for your printer.

 

Enhanced CDs Stop Playing

 

Audio tracks on Enhanced Compact Discs may stop playing if 
you open a program, access a file, or use the Finder. 
Enhanced CDs contain both audio and data information, such 
as text, movies, or multimedia software. On occasion, the 
Finder needs to access information about the data portion of 
the CD, which causes the audio to stop playing. This problem 
does not occur with standard audio CDs.

 

Apple Telecom Software

 

The Apple Telecom software provided in the CD Extras folder 
on the Mac OS 8 CD is for PowerPC computers only. Also, the 
Apple Fax Gateway is no longer supported and will be 
removed when you install the new version of Apple Telecom. 
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If you already have an earlier version of Apple Telecom 
installed on your computer, a regular installation of Mac OS 
8 does not remove or alter it. However, if you perform a 
clean installation of Mac OS 8, you will need to reinstall 
Apple Telecom software. If you have a PowerPC computer, 
use the installer on the Mac OS 8 CD. If you have a 68040-
based Macintosh, reinstall your previous version.

 

Important:

 

 If you have a 68040 (or earlier) Macintosh, do 
not install the Apple Telecom software included with Mac OS 
8.

 

Express Modems and GeoPort Adapter

 

If you have an Express Modem or GeoPort Adapter, and a 
68040-based Macintosh, you may experience unexpected 
disconnections when accessing the Internet, the Internet 
Registration Server, and online services. External modems 
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that do not use the Apple Telecom software will not 
experience this problem.

 

Internet Setup Assistant and Static IP Addresses

 

If you perform a clean installation of Mac OS 8, and you are 
connected to the Internet via a LAN (instead of a modem 
connection) and you have a static IP address, you should set 
the AppleTalk control panel to use ethernet before using the 
Internet Setup Assistant. This is necessary so the assistant 
can update your configuration settings with the information 
you enter. After you use the assistant, open the TCP/IP 
control panel to activate TCP/IP for your computer.

 

Desktop Printing Extension and Mac OS 8

 

The Desktop Printing Extension is unnecessary with Mac OS 
8. If it is present in the Extensions folder it may cause a 



 

 Mac OS 8 Update   About Mac OS 8 - 10

 

system crash when you start up your computer.

 

ATI Xclaim GA and 3DMF files

 

If you have an ATI Xclaim GA card and your computer freezes 
when the monitor is set to Thousands of Colors and you try to 
load a QuickDraw 3D (3DMF) file, remove the Graphics 
Accelerator 1.0.7x extension from the Extensions folder. 
This extension is installed by the ATI Installer but is no 
longer needed with Mac OS 8.

 

ProDOS Disks and File Sharing

 

Turn off File Sharing before accessing a ProDOS (Apple II) 
disk or hard drive. Or, if you are using a ProDOS disk, eject 
it before turning File Sharing on. The Finder will be less 
responsive when you access ProDOS disks, and may freeze 
when ProDOS disks and File Sharing are used together.
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Macintosh Tutorial 

 

If you have the Macintosh Tutorial, parts of it may not work 
correctly on computers with 68040 processors and Mac OS 
8. Additionally, due to changes in the Finder and other parts 
of Mac OS 8, the information in the tutorial may not be 
correct. You can use the Mac OS Info Center to learn about 
the capabilities of your computer.

 

IR File Exchange Guide

 

The Apple Guide for the IR File Exchange control panel does 
not recognize when the File Sharing control panel is open. 
You can avoid this problem by setting your owner name in 
the File Sharing control panel, or by using the Mac OS Setup 
Assistant.
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Using Old Versions of Cyberdog With International Text

 

Using Cyberdog 1.2.1 or earlier to send or receive non-
Roman text in e-mail messages may result in information 
being lost from the end of the message. Cyberdog 2.0, 
included with Mac OS 8, solves this problem.

 

AppleScript and the Finder

 

Many of the new features of the Mac OS 8 Finder are 
scriptable, and some of the properties in previous versions 
of the Finder have changed. Additionally, some scripting 
capabilities have been removed from the Finder and placed 
into scriptable control panels. For example, you can now 
script file sharing by addressing the File Sharing control 
panel directly. These changes might require some scripts to 
be updated for use with Mac OS 8.
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Recording Scripts and Mac OS 8

 

When you record an AppleScript using the Script Editor, 
Mac OS 8 does not properly record name changes. For 
example, when you turn on recording in the Script editor 
and then change the name of an icon in the Finder, the script 
will incorrectly record as:

     set «class» of item “folder name” to “folder name”

The correct recording should be:

    select item “folder name”

    set name of selection to “new folder name”

To work around this problem, edit the script after you 
record it. Change the wording as shown above, substituting 
the correct names.
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AppleShare IP 5.0 Servers and Mac OS 8

 

Apple recommends that you use Mac OS 7.6 with AppleShare 
IP 5.0 servers. If you use Mac OS 8, you may encounter 
problems with FTP access. When several FTP clients try to 
access the same file simultaneously, the clients may receive 
one of several error messages and the server may stop 
serving files properly, or may crash when you shut it down. 
To avoid this problem until a fix is available, you can turn 
off FTP access using the AppleShare IP Web & File Admin 
application. For the latest information on AppleShare IP 5.0 
support for Mac OS 8, see the AppleShare IP web site at 
<http://appleshareip.apple.com>.
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Miscellaneous Notes

 

Internet Access in Canada

 

If you don't already have an account with an Internet service 
provider, you can obtain one using the Internet Setup 
Assistant, or you can choose one from the list in the 
International Internet Access file in the Internet Extras 
folder on the Mac OS 8 CD. Read this information before 
using the Internet Setup Assistant.

 

Internet Access in Latin America, Australia, New 
Zealand, and Asia

 

If you don't already have an account with an Internet service 
provider, see the file International Internet Access in the 
Internet Extras folder on the Mac OS 8 CD. Read this 
information before using the Internet Setup Assistant.
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Installing the Internet Utilities

 

If you use your computer for sending e-mail, you should 
install the program DropStuff. DropStuff will install the 
StuffIt Engine that allows Claris Emailer to compress and 
send files via e-mail. The DropStuff installer is located in 
the Aladdin folder of the Internet Utilities folder, in the 
Internet folder on your hard disk.

 

General Controls, Empty Trash Warning, and Views 
Settings

 

These settings are restored to their default values after 
installing Mac OS 8. Additionally, in previous versions of 
Mac OS, view settings such as “snap to grid” and “calculate 
folder size” applied to all folders. When you install Mac OS 8 
your previous setting is used as the default, but you can now 
select different settings for each folder and the desktop. 



 

 Mac OS 8 Update   About Mac OS 8 - 17

 

If you use a disk with Mac OS 8, and then use it on a 
computer with a previous version of the Mac OS, you'll 
notice that some of your views may change. For example, if 
you set a folder to “view by button,” then access that folder 
with System 7.6, the files will be displayed in large icon 
view because button view is not available under the older 
system software. Additionally, if you ejected the disk with 
open windows on a Mac OS 8 computer, the windows will not 
automatically reopen on older versions of Mac OS.

 

Unusual or Inconsistent Appearance

 

Some applications will exhibit unusual or inconsistent 
cosmetic anomalies when used with Mac OS 8. These are 
harmless, but if they bother you turn off the system-wide 
setting in the Appearance control panel. Contact the 
manufacturer of the program to see if an updated version of 
the program is available.
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Entering Comments for Floppy Disks

 

With Mac OS 8 you can no longer enter comments in the Get 
Info window for floppy disks. The space formerly used for 
storing comments is now used by Mac OS 8 to store the view 
settings (button view, etc.) for the disk and its folders.

 

Stationery Pads and Mac OS 8

 

If you use a stationery pad with an application that does not 
directly support stationery, Mac OS 8 will automatically 
make a new copy of the stationery and open it using the 
application. In previous versions of Mac OS, you were asked 
to enter a name for the new copy; now it is opened as an 
untitled document automatically.
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Disk Cache Setting and Better Performance

 

If opening windows, emptying trash, and other activities in 
the Finder seem very slow, increase the size of the disk 
cache. Click the “Use Defaults” button in the Memory 
control panel to set the cache to the minimum recommended 
size for your system. With Mac OS 8, you can perform many 
file-related activities at the same time, and increasing the 
size of the disk cache will help performance.

 

Using Desktop Pictures

 

If you select a desktop picture that is on a CD or external 
disk, the picture might not be available the next time you 
start up your computer and will not be displayed. You can 
prevent this by copying the picture you want to display to 
your hard disk.
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Slow Screen Redrawing

 

If the desktop is redrawn slowly after closing a window, 
your computer might be running low on memory. Set 
Desktop Pictures to display a pattern, instead of a picture, 
to speed up the redrawing process.

 

PowerBook 2400 Computers and OT/PPP

 

After installing Mac OS 8, the printer/modem port may be 
in use by AppleTalk. If you also install OT/PPP, you must 
turn off AppleTalk then restart your computer in order to 
release the port for use by OT/PPP. Turn off AppleTalk 
using the AppleTalk control panel. Then restart the 
PowerBook and select the modem/printer port in the OT/
PPP control panel.
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Using Acrobat PDF Documents

 

Some of the manuals included with Mac OS 8 are in Adobe 
Acrobat format. These files have “pdf” at the end of their 
names. To view or print these documents you must install 
Adobe Acrobat Reader, located in the CD Extras folder on the 
Mac OS 8 CD.

 

QuickTake Image Access

 

When you are copying pictures from a QuickTake 100 or 
Quicktake 150 camera to your computer, make sure all the 
pictures you want have finished copying before you erase the 
contents of the camera. Previously, you couldn't erase the 
camera until copying was completed. With Mac OS 8, you can 
copy and delete files at the same time so it's possible to ac-
cidently erase the pictures before they have been copied. You 
can’t recover a picture once it’s erased from the camera.
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QuickTake 150 Software Installs Old Version of 
QuickTime PowerPlug

 

Mac OS 8 includes a new version of the QuickTime 
PowerPlug for computers with PowerPC microprocessors.  
The QuickTake 150 installer replaces this with version 2.0. 
Remove the QuickTime PowerPlug file from your Extensions 
folder (inside the System Folder) before installing 
QuickTake 150 software. After the QuickTake software is 
installed, drag the PowerPlug file back to the Extensions 
folder. 

 

Using a RAM Disk

 

On some models of Mac OS-based computers, RAM disk 
contents are saved by writing to the hard disk when the 
computer shuts down. Then the contents are reloaded at 
startup. If the RAM disk is large, this may result in a delay 



 

 Mac OS 8 Update   About Mac OS 8 - 23

 

when you shut down or start up your computer.

 

Apple HD SC Setup Program

 

After you install Mac OS 8, you cannot use the obsolete Apple 
HD SC Setup program to initialize your hard drive. Use the 
Drive Setup program supplied with Mac OS 8 instead.

 

Apple CD-ROM and Non-Apple CD-ROM 
Incompatibilities

 

If your computer or CD-ROM drive is not manufactured by 
Apple, or you have an Apple CD-ROM drive which has been 
updated with a non-Apple driver, incompatibilities may 
result. To permit your CD-ROM drive to function correctly, 
remove “Apple CD-ROM” from the Extensions folder, and 
reinstall the software to support your CD-ROM device.



 

 Mac OS 8 Update   About Mac OS 8 - 24

 

Network Software Installer Version 1.5.1 Installs Older 
Version of AppleTalk

 

The Network Software Installer installs an earlier version 
of AppleTalk than the one included with Mac OS 8. If an 
earlier AppleTalk version is installed, Open Transport 
networking software will not work.  Do not use the Network 
Software Installer after installing Mac OS 8. 

 

Password Security Protects One Partition Only

 

The PowerBook Password Security control panel asks for a 
password in order to start up the computer. If you have 
formatted your internal hard disk so it has more than one 
partition, only the start up partition will be password 
protected. Additionally, if more than one partition has a 
System Folder, the PowerBook may start up from a non-
protected partition.
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Password Security on PowerBook 2400 and 3400 
Computers

 

The Password Security control panel is incompatible with 
Mac OS 8 on PowerBook 2400 and PowerBook 3400 
computers. The security protection that the control panel 
provides works correctly on these PowerBook computers, 
but you cannot use the current version of the control panel 
to set up password protection. As an alternative, you can 
boot your PowerBook using a Disk Tools diskette, then open 
the Password Security control panel on your hard drive and 
turn password protection on, off, or set your password. 

 

AutoRemounter Control Panel Is for PowerBooks Only

 

The AutoRemounter control panel automatically remounts 
network devices after a PowerBook computer awakes from 
sleep. On desktop computers, network devices are not 
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unmounted when the computer sleeps, so AutoRemounter is 
not needed.

 

Serial Port In Use Error Message on PowerBook 
Computers With IrDA

 

If you receive an error message about the modem port being 
in use when you try to establish a PPP connection using OT/
PPP, open the Infrared control panel and change the setting 
to IRTalk. 

 

Switching Between a LocalTalk Network and a Serial 
Printer

 

If you use the same port to alternately connect to a LocalTalk 
network and a serial printer, the port is not always 
correctly released after you turn off AppleTalk to use the 
printer. If you have trouble printing after turning 
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AppleTalk off, restart the computer. 

 

3D Images Cannot Be Viewed With OpenDoc 3DMF 
Viewer 1.0.1 With QuickDraw 3D 1.5 or 1.5.1 Installed 

 

If QuickDraw 3D 1.5 or 1.5.1 is installed, a message about 
insufficient memory appears when attempting to place a 3D 
image in an OpenDoc document. Increasing the viewer’s 
memory size with the Get Info command in the File menu 
does not solve the problem. To use the 3DMF Viewer, install 
an earlier version of QuickDraw 3D.

 

Internal Speaker on Power Macintosh 5500 and 6500 
Computers Remains Muted After Disconnecting External 
Speakers

 

If the external speakers are connected when the computer 
starts up and then are disconnected, the internal speakers 
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remain muted. To work around this problem, restart the 
computer after disconnecting the external speakers. The 
internal speaker should work normally. 

 

Using Monitors & Sound With Add-on Devices

 

If you have a video or sound device that cannot be accessed 
using the Monitors & Sound control panel, use the Monitors 
control panel, or the Sound control panel, instead. Copies of 
these older control panels are installed in the Apple Extras 
folder on your hard disk. Unless you need to use these older 
control panels, use the unified Monitors & Sound control 
panel instead.

 

File Sharing and Users & Groups

 

If you want to be able to use the File Sharing and Users & 
Groups control panels from a remote computer, you must 
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remove the FileSharing Commands scripting addition from 
the Scripting Additions folder and turn on the Program 
Linking setting for both control panels.

 

File Sharing Control Panel and AppleShare

 

If you have AppleShare installed, some of the instructions 
about file sharing in the onscreen help will be incorrect. 
For instructions on network identity, file sharing, and 
activity monitoring, refer to the AppleShare documentation.

 

ARA 2.1 Personal Server and Users & Groups Control 
Panel

 

AppleTalk Remote Access Personal Server 2.1 cannot 
automatically open the Users & Groups control panel when 
you choose Users & Groups in the ARA setup menu. Instead, 
open the control panel by choosing it from the Control 



 

 Mac OS 8 Update   About Mac OS 8 - 30

 

Panels submenu, in the Apple menu.

 

PowerBook 190, 190cs, and 5300cs Computers

 

The PowerBook 190cs and 5300cs display may appear blank 
when you first restart after installing Mac OS 8, as well as 
every time after resetting PRAM. This is because the power 
manager is being updated on the PowerBook. Restarting the 
PowerBook once more will result in a normal screen. To 
shut down the PowerBook safely, press the Power button one 
time (which brings up the shutdown dialog box) and then 
press the Return key.

 

Reinstalling Printer Drivers

 

If you perform a clean installation of Mac OS 8, and an icon 
for your printer is not available in the Chooser, you may 
need to reinstall the software that came with your printer. 
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If you have a StyleWriter, StyleWriter II, or StyleWriter 
1200, you can use the StyleWriter 1500 driver that comes 
with Mac OS 8 instead of installing your original printer 
software. If you have a Color StyleWriter 2200 or Color 
StyleWriter 2400, you can use the Color StyleWriter 2500 
driver instead.

 

Drive Setup and Energy Saver

 

Use the Energy Saver control panel to set the hard drive 
sleep setting to “Never” when you use Drive Setup to 
perform an extended operation, such as testing the disk or 
initializing the disk with a low level format or zeroing all 
the data. This will prevent errors caused by the hard drive 
spinning down before Drive Setup completes its operation.
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Mac OS 8 Hard Disks and Older Macintosh Computers

 

The hard disk driver software that the Installer places on 
Apple hard disks is not compatible with computers that have 
a 68000 microprocessor. If you have an external drive with 
Apple driver software connected to your computer when you 
install Mac OS 8, the updated driver software will cause an 
error if you connect that drive to a Macintosh Plus, 
Macintosh Classic, Macintosh SE, Macintosh Portable, or 
PowerBook 100 computer.

 

Using MacsBug and Mac OS 8

 

Mac OS 8 requires a new version of MacsBug. (MacsBug is a 
tool for software developers.)  For information, check the 
Apple developer Web site at <http://devworld.apple.com>. 

Advanced users can find additional technical information in 
the Mac OS 8 Tech Notes document. This document is located 
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on the World Wide Web at <http://devworld.apple.com/dev/
technotes.shtml>.
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About Internet Access

 

This section contains late-breaking news about Internet 
Access for the Mac OS.  You will find instructions on how to 
set up Internet Access and solutions for common problems in 
the manual that came with your software or computer.  
Additional information about the Internet and Internet 
Access for Mac OS 8 can be found in the Info Center.

 

What To Do First

 

If you have not previously connected to the Internet with 
this computer, you need to configure the Internet settings.  
Double-click the Internet Setup Assistant icon located in 
your Internet folder to begin.  If you already have an account 
with an Internet service provider, you should have that 
information handy before you begin.  
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Customers in Canada

 

The Internet Setup Assistant can help you create 
automatically a new Internet account online, or set up an 
existing dial-up or LAN Internet account.  Double-click the 
Internet Setup Assistant icon located in your Internet folder 
to begin. For more information on how to set up an Internet 
account in Canada, refer to the Internet Extras folder on 
your Mac OS CD.

 

Customers in Asia, Australia, Latin America, and New 
Zealand

 

The Internet Setup Assistant can help you set up an existing 
dial-up or LAN Internet account.   If you do not yet have an 
Internet account, you need to set up an account with an 
Internet service provider first. For more information on 
how to set up an Internet account in your country, refer to 
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the Internet Extras folder on your Mac OS CD. Then double-
click the Internet Setup Assistant icon located in your 
Internet folder to begin.  

 

Additional Software

 

If your Mac OS software came with a CD, refer to the CD and 
the Internet Extras folder for late-breaking software to help 
you access and use the Internet more effectively.

 

Auto-Dial and Auto-Disconnect Settings

 

Your computer is set to dial your Internet service provider 
automatically when an application that requires an Internet 
connection is used.  In addition, it has been set to disconnect 
automatically after 10 minutes of network inactivity.  Use 
the PPP control panel to change or verify these settings.
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TCP/IP Connection Options and Internet Access

 

Apple Internet Connection Kit Preferences

 

If you used the Apple Internet Connection Kit (AICK) before 
you upgraded to Mac OS 8, then your Internet configurations 
are transferred automatically.  Before you use Internet 
Access in Mac OS 8 it is a good idea to verify your Internet 
configurations. To do this, launch the Internet Setup 
Assistant and select Update. Then select Modify and complete 
the interview process.

During the interview process notice that your login and e-
mail passwords are blank.  This is for security reasons.  You 
must enter the same passwords you used in AICK.  If you have 
forgotten your passwords, contact your Internet Service 
Provider.
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Ethernet

 

Internet Access for Mac OS 8 supports the Ethernet option in 
the TCP/IP control panel for Ethernet built into your 
computer.  If you have added an Ethernet card to your 
computer, you must open the TCP/IP control panel to verify 
the settings are correct, and make changes if necessary.

MacIP

Internet Access for Mac OS supports MacIP configurations 
that use dynamic (or server-based) addressing, such as the 
MacIP configuration used for Apple Remote Access. It does 
not support MacIP configurations that use static IP 
addresses. 

"Load Only When Needed" 

The "Load only when needed" feature is turned on by default. 
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We recommend that you do not change this setting. When 
“Load only when needed” is turned on, TCP/IP is not loaded 
until you open a network connection.  If you turn this feature 
off, and auto-dial is turned on, then your modem will dial 
every time you start up your machine.  To turn this feature 
on or off, do the following:

1.  Open the TCP/IP control panel.

2.  Choose User Mode from the Edit menu.

3.  Click Advanced; then click OK.

4.  Click Options; then click the checkbox next to "Load only 
when needed."

5.  Click OK.

6.  Close the TCP/IP control panel.
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TCP/IP, PPP and Modem Configurations From Previous 
Versions of Mac OS

TCP/IP, PPP, and Modem configurations from prior 
versions of Mac OS must have the same name for them to 
work with Internet Access in Mac OS 8.  Otherwise changes 
you make to the TCP/IP, PPP, or Modem control panels will 
not be reflected in Internet Access for Mac OS 8. 

Follow these steps to rename PPP and modem configurations 
so they match your TCP/IP configurations:

1.  Open the TCP/IP control panel.

2.  Choose Configurations from the File menu to view your 
TCP/IP configurations.

3.  Make a note of each configuration's name. Your list of 
TCP/IP configurations should be equal to the number of 
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Internet configurations you have.

4.  Click Done and then close the TCP/IP control panel.

5.  Open the Modem control panel.

6.  Choose Configurations from the File menu to view your 
modem configurations.

7.  Select a configuration and click Rename.  Type the name 
that matches the corresponding TCP/IP configuration, and 
then click OK. 

8.  Repeat step 7 until all your modem configurations have 
been renamed.

9.  Click Done and then close the Modem control panel.

10.  Open the PPP control panel.
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11.  Choose Configurations from the File menu to view your 
PPP configurations.

12. Select a configuration and click Rename.  Type the name 
that matches the corresponding TCP/IP configuration, and 
then click OK.  

13.  Repeat step 11 until all your PPP configurations have 
been renamed

14.  Click Done and close the PPP control panel.

Length of Configuration Names

When you use Internet Access for Mac OS you must limit the 
length of a configuration name to 32 characters. If you used 
TCP/IP or other control panels to create a configuration 
with a longer name, you must rename the configuration in 
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order to use it with Internet Access for Mac OS. 

To rename your configurations, follow the steps for 
renaming PPP and modem configurations outlined in the 
previous section “TCP/IP, PPP, and modem configurations 
from previous versions of Mac OS.” Be sure to shorten the 
name of the TCP/IP configuration when you open the TCP/IP 
panel.

Modem scripts

Additional modem scripts can be found in the CD Extras 
folder located on the CD that came with your Mac OS 
software.
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Password length

For security reasons, the Internet Setup Assistant displays 
16 bullets in the Password boxes for e-mail and login 
passwords, regardless of the length of your password. 

Proxies and Other Internet Config Settings

Internet Access for Mac OS 8 only manipulates your e-mail 
and news settings in Internet Config.  You need to make sure 
other Internet Config settings, such as proxies, for each of 
your Internet configurations are set properly.  To adjust 
other Internet configuration settings, double-click the 
Internet Config icon located in the Internet Utilities folder in 
your Internet folder.  Then click the appropriate button, 
such as Firewalls to change proxies.



 Mac OS 8 Update   About Internet Access - 45

Web Browser Issues

Using Netscape Navigator 2.0 After You've Used 3.01 

Mac OS 8 installs Netscape Navigator 3.01. If you use 
Netscape Navigator 3.01 and then want to go back to using 
Netscape Navigator 2.0, follow these steps to restore your 
preferences and bookmarks:  

1. Quit Netscape Navigator if it is open.

2. Open the Backup folder in the Internet folder.

3. Drag the Netscape Preferences icon into your Netscape 
2.0 folder.

4. Drag the Netscape Bookmarks.html icon into your 
Netscape 2.0 folder.
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5. Open Netscape Navigator 2.0.

Using Netscape Navigator 3.01 With 2.0 Plug-ins 

When Mac OS 8 was installed, a new Netscape Navigator 
folder was created in the Internet Applications folder located 
in the Internet folder on your startup disk.  You must move 
your Netscape Navigator 2.0 plug-ins to the Plug-ins folder 
located in this Netscape Navigator folder. 

Web Browser Memory Needs for QuickTime and 
Shockwave Plug-ins

For optimum performance when viewing QuickTime or 
Shockwave media over the Internet, you should increase the 
amount of memory allocated to Netscape Navigator.  To do 
this:

1.  Open the Internet folder.



 Mac OS 8 Update   About Internet Access - 47

2.  Click the Netscape alias.

3.  Choose Get Info from the File menu.

4.  Click Find Original.  The folder containing the Netscape 
icon opens, and Netscape is selected.

5.   Choose Get Info from the File menu.

6.  If you are using QuickTime only, increase the minimum 
size in the Memory Requirements box by 1000.

7.  If you are using Shockwave only, increase the minimum 
size in the Memory Requirements box by 3000.

8.  If you are using both QuickTime and Shockwave, increase 
the minimum size in the Memory Requirements box by 
4000.
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Obtaining a Web Browser That Uses Highly Secure (128-
bit) Encryption

Mac OS 8 installs Netscape Navigator 3.01 with 
International (40-bit) encryption.  This supports a 
standard level of security suitable for worldwide export and 
use.  In the United States and Canada, some electronic 
commerce web sites, such as banking and shopping sites, 
recommend using non-International (128-bit) encryption 
for a greater level of security.  Contact Netscape (http://
www.netscape.com) or Microsoft (http://
www.microsoft.com) for more information.

Troubleshooting

You can find additional information on the problems listed 
below in the onscreen help on your computer or in 
documentation for your Mac OS software and computer. 
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Netscape Is Unable to Locate the Registration Server

You see this message when you try to register with an 
Internet service provider: "Netscape is unable to locate the 
server: reggie.netscape.com  The server does not have a DNS 
entry.  Check the server name in the Location (URL) and try 
again."  

Solution:  You cannot check the server name in the Location 
box because Netscape runs in kiosk mode when it connects to 
the registration server. Instead, you must quit Netscape and 
try connecting again.  If reconnecting does not work, you 
may need to try registering at a different time.

Reinstalling Internet Access Components

If your Internet Access files become corrupted and you want 
to do a clean installation, you must remove all Internet 
Access files before you use the Installer.  If you do not, files 
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with current version numbers will not be replaced whether 
or not they are corrupted.  The Internet Access files that 
must be removed are the Internet folder, the Internet Access 
extension, and the following items which are located in the 
Preferences folder in your System Folder:  Netscape ƒ, 
Internet Preferences, Internet Setup Preferences, and 
Internet Dialer Preferences.

Switching From Internet Access in Mac OS 8 to Apple 
Internet Connection Kit

If you modify your old Apple Internet Connection Kit (AICK) 
configuration with the Internet Setup Assistant, the 
Assistant switches TCP/IP from MacPPP to PPP.  If you 
open AICK dialer, you see a dialog box that asks you to go to 
the TCP/IP control panel.  Open the TCP/IP control panel 
and choose MacPPP in the Connect Via pop-up menu.  
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If you decide to use AICK after Internet Access for Mac OS 8 
is installed, you can't register with a new Internet service 
provider online.  You must use the Internet Setup Assistant 
to register with a new ISP.

If you switch back and forth between Internet Access for Mac 
OS 8 and AICK, and you have multiple ISP settings with AICK, 
you will find duplicate configurations when you use Internet 
Access. Although this does not create a problem, you may 
want to remove the duplicate configurations.  You can use the 
Internet Setup Utility to remove duplicate configurations.  
The Internet Setup Utility is located in the Internet Utilities 
folder located in the Internet folder on your hard disk. 
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Changing Your Configuration Type From LAN to 
Modem or From Modem to LAN

You can't use the Modify feature of the Internet Setup 
Assistant to change an Internet configuration type.To change 
an Internet configuration from LAN to Modem, or from 
Modem to LAN you must first use the Internet Setup 
Assistant to remove the configuration. Then you use the 
Internet Setup Assistant to add the configuration with the 
new type. 

Before you remove the configuration you should write down 
any information that you may need, such as your login name 
and password. 
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About Mac OS Runtime for Java 
Version 1.0.2

Introduction

Mac OS Runtime for Java (MRJ) is Apple’s implementation 
of the Java runtime environment based on software from 
Sun Microsystems, Inc. With MRJ, Mac OS applications can 
run Java applets and applications.

MRJ 1.0.2 implements version 1.0.2 of Sun’s Java. MRJ 
1.0.2 includes Apple Applet Runner, a standalone 
application that runs Java applets, and Apple Applet Viewer, 
an OpenDoc viewer you use to put Java applets into OpenDoc 
documents. 

MRJ 1.0.2 is a minor upgrade to MRJ 1.0.1 that fixes a bug 
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where some Java applications were not able to save files.

Important:  The Applets menu in Apple Applet Runner 
includes a set of applets provided by Sun Microsystems, Inc. 
These applets were not created by Apple Computer, Inc. and 
may not follow Apple guidelines for user interaction. For 
example, buttons in an applet may have different behavior 
from buttons in applications developed specifically for the 
Mac OS.

System Requirements

MRJ 1.0.2 works on computers with 68030 or 68040 
microprocessors or PowerPC microprocessors. You also 
need System 7.5 or later, a minimum of 8 MB of RAM (16 
MB is strongly recommended) and at least 7 MB of free disk 
space. Computers with 68030 or 68040 microprocessors 
must have 32-bit addressing turned on. This can be done by 
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using the Memory control panel.

The Apple Applet Viewer requires OpenDoc 1.0.4 or later. To 
get OpenDoc, see the OpenDoc Web page at <http://
www.opendoc.apple.com/>. MRJ 1.0.2 and the Apple Applet 
Runner do not require OpenDoc.

Using Java applets over the Internet requires MacTCP 2.0.4 
or later, or OpenTransport 1.1 or later with TCP/IP, and an 
active Internet connection.

MRJ 1.0.2 works with Cyberdog 1.2.1 or later. See the 
Cyberdog Web page at <http://www.cyberdog.apple.com/> 
for more information.
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What’s Installed With MRJ?

The MRJ 1.0.2 installer places the required software 
components in your System Folder. If necessary, the 
installer will force you to restart your computer before 
using MRJ.

WARNING: If you have been using a pre-release version of 
MRJ, you need to remove files installed with the pre-
release version before installing version 1.0.2. Use the list 
below to check the files you need to remove. However, do not 
remove the file named “Text Encoding Converter” or the 
folder named “Text Encodings.” 

On all computers, MRJ 1.0.2 installs:

• Mac OS Runtime for Java folder in the Apple Extras folder 
at the root of the startup disk
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• MRJ Libraries folder in the Extensions folder of the active 
System Folder

• Text Encoding Converter in the Extensions folder of the 
active System Folder

• Text Encodings folder in the active System Folder

If you have a 68030 or 68040 computer, MRJ 1.0.2 also 
installs:

• CFM-68K Runtime Enabler in the Extensions folder of the 
active System Folder

If you have OpenDoc installed, MRJ 1.0.2 also installs:

• Apple Applet Viewer Libraries in the Editors folder of the 
active System Folder
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• Apple Applet Viewer Stationery in the Stationery folder at 
the root of the startup disk

Using the Apple Applet Runner produces a preferences file 
named “Apple Applet Runner Prefs” in the Preferences 
folder of the active System Folder.

Description of MRJ Components

MRJ 1.0.2 contains the system components necessary to use 
Java. It also includes two demonstration tools that use these 
components to run Java applets.

System Components

The MRJ 1.0.2 installer puts a folder named “MRJ 
Libraries” in the Extensions folder of the active System 
Folder. This folder contains two items necessary for Java 
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support: MRJLib and the MRJClasses folder.

Apple Applet Runner

You use Apple Applet Runner to run Java applets from your 
local disk. If you have MacTCP or Open Transport installed 
and an active Internet connection, you can also run Java 
applets over the Internet. 

You can open URLs or local HTML files containing <applet> 
tags from the Applet Runner’s File menu. In addition, you 
can drop HTML files containing <applet> tags onto the Apple 
Applet Runner application icon from the Finder. You will 
only see the applet itself inside Apple Applet Runner; if you 
use a Web browser to open the HTML file, you may see 
additional information.

Apple Applet Runner remembers URLs of remote (“http://
…”) or local (“file:///…”) applets. This information is 
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stored in the Apple Applet Runner Prefs file in the 
Preferences folder of the active System Folder. A few sample 
URLs are available by choosing Open URL from the File 
menu; you may add more URLs if you desire. You must have 
an active Internet connection to use these remote URLs.

Demonstration applets are available under the “Applets” 
menu in Applet Runner. You may run these demonstration 
applets even if you do not have an active Internet connection. 
These applets are stored locally in the Applets folder.

Apple Applet Viewer (for OpenDoc)

You use Apple Applet Viewer to place Java applets into your 
OpenDoc documents.

A folder called “Apple Applet Viewer” is installed in your 
Editors folder and the Apple Applet Viewer Stationery file is 
installed in your Stationery folder. Refer to your OpenDoc 
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documentation for instructions on using stationery.

You use Java applets by doing dragging one of the following to 
the Apple Applet Viewer frame:

1. An HTML file that contains an <applet> tag, 

2. A text file that contains a URL for an HTML document 
containing an <applet> tag, or

3. A Scrapbook clipping that contains either a URL for an 
HTML document containing an <applet> tag or an <applet> tag.

Note: You must have an active Internet connection to use 
applets at remote URLs.
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Tips for Using MRJ

OpenDoc

If you do not have OpenDoc installed when you install MRJ 
1.0.2, the Apple Applet Viewer will not be installed. If you 
install OpenDoc later, you must reinstall MRJ to use the 
Applet Viewer.

Memory Usage

MRJ uses system memory to run Java applets and 
applications. Applications allocate their own application 
memory, leaving less memory available to the system. If an 
application that uses MRJ (such as the Applet Runner or 
Cyberdog) is using an especially large amount of memory, 
you may have trouble running large Java applets or 
applications. If you encounter problems, try quitting 
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applications you aren’t using. If you still cannot run the 
applet or application, try reducing the amount of memory 
used by the application that is using MRJ. To reduce an 
application’s memory size, first quit the application, then 
select the application’s icon and choose Get Info from the File 
menu. Type a smaller number in the Preferred Size field. 
(However, do not set the preferred size smaller than the 
indicated minimum size).

Known Problems

• You must restart your computer after installing MRJ. If 
you attempt to run MRJ without restarting, MRJ may 
behave in unexpected ways.

• Do not remove the Text Encodings folder from the System 
Folder or the Text Encoder Converter file from the 
Extensions folder. Removing these items may cause 
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problems while using MRJ or using other applications 
requiring these files.

• In pre-release versions of MRJ, the preferences file was 
named “Applet Runner Prefs.” If you had a pre-release 
version of MRJ installed, make sure you throw the “Applet 
Runner Prefs” file away. (The old file may conflict with 
preference files created by applet runner applications from 
other companies.)

• There is a known problem with the PPCExceptionEnabler 
extension. This extension is installed by Macintosh Common 
Lisp (MCL) 3.9. If you have this extension, you must 
remove it before running MRJ. Future versions of MCL will 
not require this extension.

• There are known problems with some applets when using 
MRJ 1.0.2 with Microsoft Internet Explorer, including 
display problems, sound problems and possible crashes. We 
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are working with Microsoft to resolve these problems in a 
future release of Internet Explorer.

• If you are running applications or applets compiled with 
the JavaSoft 1.0.2 JDK release for Macintosh, you may 
encounter numerics-related problems. Specifically, 
floating-point constants (and in some cases computed 
integer constants) may not be accurate. If possible, use 
another Java compiler to recompile any applications or 
applets displaying this problem.

• If all the images and sounds an applet uses don’t appear, 
there may not be enough memory available for all the images 
and sounds. You may be able to free up memory by quitting 
all applications (such as the Apple Applet Runner and Apple 
Applet Viewer) that use MRJ. If necessary, try quitting 
other applications as well. After quitting the applications, 
try reopening Apple Applet Runner or Apple Applet Viewer. 
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See Memory Usage above for additional information.

• Some Java applets (such as Clock) or applications that are 
processor intensive may cause other applets to open or run 
slowly, or may cause them not to open at all. To improve 
performance, try closing applets or applications that you 
are not using.

• The Apple Applet Viewer does not report some errors. If an 
applet does not open in Apple Applet Viewer, try opening it 
with Apple Applet Runner to see if an error message 
appears.

Further Information and Reporting Problems

See our Web site at <http://applejava.apple.com/> to find 
out about future releases of Mac OS Runtime for Java or get 
information on how to report problems with the software.



 Mac OS 8 Update   About Mac OS Runtime for Java Version 1.0.2 - 67

Other Applets on the Internet

There are thousands of applets available on the Internet. Two 
good starting points for finding applets are:

• <http://www.javasoft.com/>

• <http://www.gamelan.com/>

Software Development Kit Available

A software development kit (SDK) is available for MRJ 
1.0.2. The MRJ SDK includes interfaces to the runtime 
environment that allow software developers to:

• Run Java applets and applications within a Macintosh 
application

• Access the Java runtime from a Macintosh application
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• Call Java methods from C and C++

• Call native methods from Java

• Build standalone Java applications

The SDK also includes a utility to run Java applications.

See our Web site at <http://applejava.apple.com/> to get the 
MRJ SDK.

Java Not Fault-Tolerant

The Java technology is not fault-tolerant and is not designed, 
manufactured or intended for use or resale as on-line 
control equipment in the operation of nuclear facilities, 
aircraft navigation or communication systems, or air 
traffic control machines in which the failure of the Java 
technology or Mac OS Runtime for Java could lead directly to 
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death, personal injury, or severe physical or 
environmental damage.
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About Mac OS Personal Web Sharing
This section introduces the Mac OS Personal Web Sharing 
software and contains late-breaking information about 
setting up and using your own Web server.

Mac OS Personal Web Sharing is the easiest way to share 
your information with everyone on your intranet, no matter 
what type of computer or browser they’re using. All you do 
is put the items you want to share in the server folder and 
turn on the server.

Installing Personal Web Sharing

To install Personal Web Sharing, double-click the 
WebScript icon in the Web Sharing folder. To set up your 
Web server, see the instructions in “Using Personal Web 
Sharing” in the Web Pages folder (which is created when 
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the software is installed) at the root level of your hard disk.

The Web Pages folder also contains a file named 
“Default.html” which you can use as the home page for your 
server. You can modify this file or choose a different home 
page (see “Using Personal Web Sharing” for instructions).

Compatibility

Personal Web Sharing is compatible with Open Transport 
1.1.1 (or a more recent version).  MacTCP 2.0.6 is 
supported only with System 7.5.5, but we have noticed some 
inconsistencies with large volume connections. 

Important:  A continuous TCP/IP connection and a static IP 
address are strongly recommended for use of Personal Web 
Sharing.  If your system does not have a persistent 
connection and a static IP address, any interruption in the 
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network connection could negatively affect TCP/IP signals.  
In some circumstances, this could cause the system to 
appear to hang. To avoid this problem, always use a 
continuous TCP/IP connection and a static IP address.  

Note:  This problem could also occur with other server 
applications.

Known Problems

Virtual Memory Off

Web servers expose a bug in the Ethernet driver for PCI-
based computers. To ensure that your server works 
correctly, either turn off virtual memory (VM) or install 
Mac OS System 7.6.
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OT/PPP

There is a known problem using OT/PPP 1.0 with Personal 
Web Sharing.  This software runs as a background 
application, which conflicts with the dialog box that PPP 
tries to display when reconnecting (if the connection has 
been broken). This can cause your system to crash. To work 
around this problem, turn off the automatic reconnect option 
in the PPP control panel. 

Follow these steps to turn off the automatic reconnect option:

1.  Open the PPP control panel.

2.  Click the Options button.

3.  Click the Connection tab. 

4.  Click to remove the X from the box labeled "Connect 
automatically when starting TCP/IP applications" and    
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click OK.

5.  Close the PPP control panel.

Location of Server Folder

To ensure that the correct content is served, the Web Pages 
folder (or other server folder) should be located no more 
than five levels below the root level of the hard disk.

Browsers Look for “index.html” Document

Visitors to your Web server may use a browser that 
automatically looks for a document named “default.html” or 
one named “index.html” as the point of entry (home page) to 
your server, regardless of the home page you select in the 
Web Sharing control panel. This occurs because some 
browsers “assume” that the home page will have one of the 
names noted above, and they only look for the home page 
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name you specified after looking for either “default.html” 
or “index.html.”  You can avoid having visitors 
inadvertently see the wrong document by renaming any files 
named “default.html” and “index.html” (whether at root 
level or inside a nested folder on the server). If you change 
document names, be sure to revise any links to the renamed 
documents so they reflect the new name.

Personal NetFinder and an “index.html” Document

In Personal NetFinder view (similar to list view in the 
Finder), if there is a document named “index.html,” it will 
open in the visitor’s browser. Therefore visitors will see 
that document as if it were a home page, and the list view of 
files at that level of the server will not be displayed.  If you 
don’t want visitors to see the list of files in a certain folder 
on your server, you can put an “index.html” document in 
that folder.  By contrast, if you want visitors always to see a 
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list of files at each level of the server’s content, don’t 
include any files named “index.html.”

File Sharing and AppleShare

If you want to use access privileges for your server, you 
must use the File Sharing privileges, which you set in the 
Users & Groups control panel of your system software. 
Personal Web Sharing is incompatible with the Users & 
Groups component of the AppleShare Server Software; do not 
use AppleShare Server Software's privileges for your Web 
server.  If you want to use the AppleShare Server Software 
and Personal Web Sharing, configure the Web server to give 
everyone read-only access in the Web Sharing control panel. 

MacIP via LocalTalk

Some computers providing a server may experience slower 
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performance overall during times of heavy activity on the 
Personal Web Sharing server over LocalTalk. 

IP Addressing: Every Personal Web Sharing server will need 
a unique assigned IP address. Do not use nonstandard IP 
addressing with your server.  Some IP addresses ("0.0.0.0" 
or "1.1.1.1," for example) are reserved for network 
hardware such as routers and gateways. If you are not sure 
how to assign an IP address to your server, contact your 
network administrator.

Optimizing Personal NetFinder

As with the Finder, Personal NetFinder will take a longer 
time to display its list of files if the server contains a large 
number of files. To optimize performance, limit the number 
of items in any one folder in your server content.
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CGIs (Common Gateway Interfaces)

CGIs are applications, created by developers, that add 
functionality such as counters, image maps, and database 
access to your server. Personal Web Sharing supports CGIs 
that are compatible with MacHTTP 2.2 and WebStar 1.3.1. 
To obtain information about CGIs, contact your Internet 
Service Provider, a user group, or your network 
administrator.

Mixed-Platform Environment

Personal Web Sharing allows you to publish documents 
across multiple platforms. Because character sets may 
differ from one platform to another, you may notice a 
difference in how data is displayed on some other types of 
computers on the network. To get a more accurate 
representation of HTML documents in a cross-platform 
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environment, we recommend that you use Personal 
NetFinder to display the documents on your server.

File formats also vary from one type of computer to another 
in a cross-platform environment. Each computer on the 
network should have its browser's helper applications 
configured correctly for the types of files your server 
contains before connecting to your server. 

Non-English-Language Documents

Mac to Mac

If your server contains non-English-language pages, the 
client's browser should be set to the appropriate document 
encoding option. Please review your browser documentation 
for more information on document encoding. 
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Mac to Non-Mac

If your server contains non-English-language pages, a non-
Mac OS computer will encounter some incompatibilities.  
For example, character sets may differ from one type of 
computer to another.

Non-English System Software

Personal NetFinder displays header information in the 
language of the Finder (part of the system software) used by 
the server.
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Installing Mac OS 8
This section describes how to install Mac OS 8. It includes 
compatibility information, instructions for the Install Mac 
OS application program, and basic installation 
troubleshooting.

For more information, see the Mac OS 8 installation manual. 

WARNING:  PowerTalk is not compatible with Mac OS 8. 
After you install Mac OS 8, you won’t be able to access your 
PowerTalk mail or catalogs, nor will you be able to use your 
keychain or other PowerTalk services. See the Mac OS 8 
installation manual for more information. 

WARNING:  Application programs that use QuickDraw GX 
may not be able to print due to changes in the version of 
QuickDraw GX included with Mac OS 8. See the file About 
QuickDraw GX for more information. 
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Before You Install

• Turn off any security software that you may have installed 
on your computer.

• If you have a PowerBook, make sure that it is plugged into 
AC power and set not to go to sleep.

• If you have AppleShare software earlier than version 
3.6.4, you should upgrade to version 3.6.4 before installing 
Mac OS 8 over a network. See the document in the 
AppleShare folder in the Utilities folder for instructions.

• Write down your current Internet settings, such as the IP 
address, subnet mask, name server, and so on. After 
installation, the Internet Setup Assistant will ask you to 
enter this information.

•  Start up your computer using the Mac OS CD-ROM disc or 
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the Mac OS 8 Install Me First floppy disk. See your 
installation manual for instructions. 

If you can't start up with the Mac OS 8 disks, be sure to do 
the following additional steps:

• Turn off any virus-protection software that you may have 
installed on your computer.

• Disable all non-Apple extensions and control panels. If you 
have System 7.5 or later, use the Extensions Manager 
control panel to select the System 7.x base set of extensions 
and control panels. See the installation manual for more 
details.

• Restart your computer before installing Mac OS 8.
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Compatibility Information

Although compatibility problems are not expected, you can 
ensure a smooth upgrade by checking with the 
manufacturers of any non-Apple software you use to make 
sure it is compatible with Mac OS 8. If you do experience a 
problem, see the troubleshooting chapter in your 
installation manual for more information on isolating 
compatibility problems.  

Computers With 68040 Processor Upgrade Cards

Computers upgraded to 68040 with a processor upgrade 
card are not supported by Mac OS 8. 

Performa or Power Macintosh 5000 and 6000 Series 
Computers

Some Performa or Power Macintosh 5200 series, 5300 
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series, 6200 series, and 6300 series models cannot use 
Mac OS 8 until a hardware problem is fixed. The repairs are 
covered under the Apple repair extension program.  To see if 
your computer has this hardware problem, use the 5xxx/
6xxx Tester utility in the Utilities folder on the CD before 
installing Mac OS 8. 

Important:  The Power Macintosh or Performa 6320, 6360, 
and 5260 do not have this hardware problem. If you have a 
Power Macintosh or Performa 6320, 6360, or 5260, you 
do not need to use the tester program. 

Installing Mac OS 8

Accelerated NuBus PowerPC Computers

If you have a Power Macintosh 6100, 7100, 8100, or 
9150 with a third-party accelerator that increases the 
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clock speed of your computer, the Installer might refuse to 
install Mac OS 8 because it doesn't recognize your system. 
You can install Mac OS 8 on these computers by using the 
individual installers located in the Software Installers 
folder on the Mac OS 8 CD instead.

MacODBC and Mac OS 8

If you use MacODBC, you should either install it before 
installing Mac OS 8, or perform a custom install of 
MacODBC and make sure the ASLM extensions are not 
selected. The MacODBC installer installs older versions of 
ASLM extensions that are incompatible with Mac OS 8.

Third-Party Finder and Utility Software

Some third-party programs that extend or add features to 
Mac OS may be incompatible. Examples include programs 
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that change the way menus work, change how files are 
stored, or alter the way you work with files in the Finder. 
Contact the software's manufacturer for information about 
using such programs with Mac OS 8. This is especially 
important if you're using a program that automatically 
alters the way files are stored (such as compressing them) 
because you might not be able to access those files until you 
obtain updated software for use with Mac OS 8.

400K Diskettes and Mac OS 8

The 400K MFS diskette format is not supported by Mac OS 8. 
If you have information or programs on obsolete 400K 
diskettes that you want to access, copy the files to your hard 
disk, an 800K diskette, or a 1.44 MB diskette before 
installing Mac OS 8.
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Using the Install Mac OS program

To ensure a successful upgrade, use the Install Mac OS 
program to install the software. This program unifies the 
tasks recommended for a successful installation and 
simplifies the installation process. Refer to the Mac OS 8 
installation manual and the onscreen help in the Install Mac 
OS program for more information.

Troubleshooting Suggestions    

Disk Cannot Be Updated with the Apple Utilities

Some Apple-branded disks manufactured by third parties, 
including the Apple 365 MB external hard disk, are not 
supported by the Apple disk utilities.  If your disk cannot be 
updated with the Apple utilities, you’ll need to use a third-
party disk utility to update the driver. 
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Disk Has Problems and Cannot Be Repaired Message

If you see a message that your disk has problems and cannot 
be repaired, turn off file sharing if it is on, then try in-
stalling again. If that doesn’t work, try using another disk-
repair utility. If you don’t have another utility, or if that 
utility also doesn’t work, you may need to reinitialize the 
disk. Copy all your files to another disk first, as reinitial-
izing erases the disk. For more information about reinitial-
izing, see the manual that came with your computer. 

Cannot Start Up From CD-ROM:  Bus Error Type 11

Some customers have reported that they are unable to start 
up from the Mac OS 8 Install CD.   During the startup 
process, a dialog appears with the following message: 

'Sorry, a system error has occurred. Bus Error Type 11. 
Restart with shift key held down.'
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This issue is currently under investigation. In the 
meantime, try one of the following workarounds (listed in 
order of preference): 

1. Make sure the computer is running from the startup disk.  
Activate AppleTalk (in the Chooser for classic networking, 
or in the AppleTalk control panel for Open Transport 
networking). With the Mac OS 8 CD in the CD-ROM drive, 
restart the computer while holding down the 'c' key. 

2. With the Mac OS 8 CD in the CD-ROM drive, startup your 
computer, while pressing the letter 'c' (or cmd-opt-shft-
del if appropriate). When the Happy Macintosh icon 
appears, release all keys and hold down the shift key until 
the boot screen appears with the 'extensions disabled' 
message. 

3. Using the Mac OS 8 CD, create a startup Disk Tools disk.  
To make a Disk Tools disk, open the Disk Tools folder on the 
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Mac OS 8 CD, then open the Make Disk Tools floppies 
application.  When you startup from the Disk Tools disk, you 
will then be able to run the Mac OS 8 Installer from the CD. 
(This will only work with Apple CD-ROM drives).  

4. Use the Extensions Manager to select a minimum (base) 
set of the Mac OS extensions. Boot from the hard disk and 
install from the Mac OS 8 CD. If the installer finds any 
problems with the hard disk, it will not be able to correct 
them. 

5. Clear (zap) the Parameter RAM (PRAM). After doing 
this, restart holding down the 'c' key to start up from the 
Mac OS 8 Install CD. 

Other Problems During Installation

If you’re installing over a network, or if you have a non-
Apple CD-ROM drive and can’t start up with the CD or disk, 
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turn off all extensions that weren’t provided with your 
system software. Then restart the computer. 

If you experience other problems during installation, see 
the Mac OS 8 installation manual for instructions and 
additional troubleshooting suggestions. 
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Upgrading Workgroup Server 9650 & 
7350 Software
The following steps should be taken when planning to 
upgrade your Workgroup Server 7350 or 9650 to MacOS 8. 
The steps may include updating specific components of the 
server MacOS as well as bundled Apple and third-party 
software.

Upgrade Procedures

Workgroup Server 7350 and 9650

1 If you have the Apple RAID hard disk driver installed, 
update to Apple RAID 1.5.3. - After performing the 
update to Apple RAID 1.5.3, launch Apple RAID and then 
install/update the driver on every Apple RAID disk. 
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Make sure to install the new driver on every disk under 
the disks column.

2 Boot the server from the Mac OS 8 CD. Install Mac OS 8, 
following the installation instructions on the CD. If you 
updated the hard disk drivers as per instruction 1, you 
will get a dialog informing you that the drivers can not 
be updated. It is safe to ignore this warning.

3 Update to AppleShare IP 5.0.2. - Be sure to follow the 
installation instructions documented in the AppleShare 
IP Updater Read Me.

4 Update to Open Transport 1.2.1. This updater is part of 
the AppleShare IP Update archive.

5 Update to RunShare 3.0.1.

6 Install WGS SCSI Update 2.0. This updater is part of the 
WGS MacOs 8 Update archive. Drag copy this file into the 
System Folder of the server.
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7 Restart the server, with the Mac OS 8 CD removed from 
the drive. If you have a Workgroup Server 9650, 
continue to the appropriate 9650 model's section below.

Workgroup Server 9650/233

Note: The Workgroup Server 9650/350 ships with several 
MacOS components which are not included in the base Mac OS 
system software. In order to update your server to MacOS 8, 
you must follow these additional steps.

1 Insert the Workgroup Server Software CD in the drive.

2 Install the PCI Card Driver for the SCSI JackHammer 
card that is on the CD.

Workgroup Server 9650/350

Note: The Workgroup Server 9650/350 ships with several 
MacOS components which are not included in the base Mac OS 
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system software. In order to update your server to MacOS 8, 
you must follow these additional steps

1 Insert the Workgroup Server Software CD in the drive. 

2 Install PCI Card Drivers on WGS CD - Locate and Open 
the 'Server Additions' folder on the CD. 

3 Move the following drivers from the 'For System Folder' 
folder to the active System Folder: 

– PCI SCSI JackHammer=81 1.2.2
– Apple 10/100 Fast Ethernet

4 Install Xclaim 3D video card software - Open the Xclaim 
3D Installer folder that's also in the 'For System Folder' 
folder. Install the Xclaim software following the 
instructions in the Read Me file.
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Internet Web Sites to Download Software 
Updates
• WGS MacOs 8 Update.hqx (includes Apple Raid 1.5.3 

Update and WGS SCSI Update 2.0) 

http://swupdates.info.apple.com/

Note: The path to the update is: Macintosh/Networking-
Communications/Other N-C 

• AppleShare IP 5.0.2 (including O.T. 1.2.1) 

http://appleshareip.apple.com/downloads

• RunShare 3.0.1 

http://www.run.co.il/tech_downloads/Apple.html

TIL Article:  30251
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